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Overview of this Manual:

Torchmate CAD is an easy to use Computer Aided Design software package designed for use
with Torchmate CNC systems. Torchmate CAD includes many features that are designed for plasma
cutting including nesting, DXF importing, kerf compensation, cut order, lead in / out creation, and
scanned image editing just to name a few. This manual gives a general overview of what Torchmate
CAD’s capabilities are. When teaching a computer program that is designed to create almost anything
that can be imagined there is a certain amount of information that will inevitably be left out. It is
impossible and pretentious to assume that a manual could encompass the entire scope of every item that
could be created with Torchmate CAD. Likewise for some processes or designs there can be multiple
ways to complete the same goal, in cases like this each way may be presented. This manual is a growing
walkthrough that started with questions from phone and email, led to simple walkthroughs, and now a
cohesive document that outlines the operation of Torchmate CAD. As such any suggestions for new
methods, sections, or design ideas are always welcome. Remember Torchmate technical support is free
and unlimited if there are any questions that arise from this manual please do not hesitate to contact us.

Thank you for purchasing Torchmate CAD, welcome to the world of CNC tables and computer design.

Torchmate Technical Support
866-571-1066
775-673-2200

support@torchmate.com




Installing Torchmate CAD:

To begin installation of Torchmate CAD insert the Torchmate CAD CD packaged with a security dongle.
The installer will automatically launch. The first prompt will be to select the setup language. This
language is only for the installer, Torchmate CAD menus are only in English.

Choose Setup Language

Select the language for the inztallation from
the choices below.

[English

After selecting a language the installer will issue a reminder about inserting the security dongle. Follow
the instructions for the specific dongle being used.

InstallShield Wizard

USB Flash Dongle

If your package includes either
a Kingston or Orange-colored
dongle, then please connect it
now. Windows will automatically
detect the device, and you can
then click Next to continue.

If your package includes a Blue-
colored dongle, then please
connect it at the end of your
product install.

Cancel |:

InstallShieid




If a ‘License File Query’ screen appears the dongle has not been read yet or was inserted too soon. If
using an orange dongle the license files will be on the dongle which will appear as a removable media. If
a blue or purple dongle is being used the license files will be on the installation CD.

License File Queny

Pleaze inzert the Licenze Disk inta your COD ROM diive or
enter the comect path below and presz 0K o conbinue.

Path:
|E:"-. |[ Browse. .. ]
InztallS hield

[ Ok ][ Canicel ]

Continue with the installation.

Torchmate CAD Setup

Welcome to the InstallShield Wizard for Torchmate CAD
i ' The Ihz will inztall Torchrnate CAD on your computer. To continue, ¢

>

InstallShizd ; < Back H




Torchmate CAD Setup

License Agreement
=

CADLIME LICEMSE AGREEMENT

‘f'ou should carefully read the following terms and conditions before continuing with

the inzstallation of this software program from CADlink Technology Corporation,

[CAD k). If pou do nat agree with these terms, you should return the software and
accompanying security device within & business days of receipt and your money will be
refunded. In consideration of payment of the license fee which iz part of the price you
paid for this product, CADlink provides thiz software and licenses its use; you assume
responaibility for the selection of the software to achieve your intended results, and for
the installation. use, and results obtained from the softyare.

MOTE: A security device accompanies and is specifically dedicated ta the software
purchased by you and iz required ta be inztalled on your computer at all times during
uze of the program to ensure proper operation af the software. If the security device iz
lost. stolen or damaged by whatever means, a replacement security device dedicated to
a replacement software program must be repurchazed at CADInK's then curent
publizhed price.

LICEMSE:

r'ou may:
1. Uge the Software only on a gingle computer and then only render it operational

InstallSi

< Back H Mest » ] Cancel |

Torchmate CAD Setup

Choose Destination Location

Cancel

InstallSi

|




When prompted select ‘Full Install’.

Torchmate CAD Setup

Select Features

Installs

y including the

< Back ﬂ Mest »

1 Cancel

Torchmate CAD Setup

Select Program Folder
F

Install i

Securty - EMBASSY Trust Suite by Wave Systems
Solidw/orks 2006 SPO.0

Solidw/orks 2008

Solidw/orks 2009

Startup

Torchmate

Torchrate 2

Torchmate

der name,

< Back ﬂ Mest »

Cancel




Torchmate CAD Setup

Setup Status

figuring your ne

L

>

InstallShield

After the main CAD program is installed the installer will want to search for all fonts installed on the
computer. This is not necessary to run Torchmate CAD but allows all fonts installed on the computer to
be accessed by Torchmate CAD.

Font Installation

Welcome to the Torchmate Font Installation \wizard. To use a font in
Torchmate. it must be installed.

Clicking Continue will start the installation of TrueT ype fonts, CADlnk
WEF fonts, Corel 'WFM fonts and Adobe Type 1 fants.




Torchmate CAD Setup

InstallShield Wizard Complete

A

InstallSi

<Back H Giidh

—

Torchmate CAD is now ready for use; if a purple or blue security dongle is being used insert it after the
computer has restarted.

****IMPORTANT CONFIGURATION CHANGE****

It is necessary to change one default setting to allow simpler tool path creation. Go to ‘Options’=>
"Torchmate Setup’ = ‘Tool Path Preferences’. Uncheck the option to ‘Group tool paths with originals’

Tool Path Preferences

X
3D Chisel
" Single cut
& Double cut
I~ Group tool paths with ariginals
v fpply separately
Cancel |




Overview of Menus:

All functions of Torchmate CAD are accessed from the main screen. The largest feature of the main
screen is the work area; this section contains a gridded work area that is skirted by a material blank. The
main work area is where all drawing will be done. Around the work area are various tool bars that
contain all of the tools, shortcuts, and options for creating a drawing.

Y . e i 5 “\.
R ¥ Ny b B
A \ "":
Al :
o L+ Rulers &
a” Information Bar
% Program Menus Shortcut Bar
4 Tool Pallet
& —
P
Layer Color Pallet
Sheet Layer
Sheet Selection

euﬂlﬂﬂﬂilﬂﬁﬂﬂﬂ EHEHHHIEEIIIE#BEEEU.IDHEEDHEHHEE DGR EERFSOEEEEE
B Loy t

Rulers: The rulers sit on either side of the work area and provide a reference to the coordinates of a spot
in the work area.

Layer Color Pallet: This bar allows the color of an object to be changed; this is useful in keeping track
of various parts. The color of an object does not affect the cutting process at all and in most cases this is
an unused tab. Colors can be changed by double clicking on one of the colors, this opens a window to
change the color options.

Sheet Layer: The sheet layer is a guide used to differentiate multiple sheets of multiple objects. This bar
like the ‘Layer Color Pallet’ does not affect the cutting process and is generally unused. The sheet layer is
visible when ‘Show Fill’ is enabled in the ‘View’ menu, by default it is transparent.

Sheet Selection: This option is used to toggle between multiple sheets. Multiple sheets occur when
nesting or other options that will create additional sheets. This option enables these sheets to be paged
through if multiple sheets exist.

Shortcut Bar: The shortcut bar contains icons that serve the same function as certain options in the
program menus. Generally these options are for selections that are used frequently. This menu can be
customized by going to ‘View’ = ‘Toolbars’ = ‘Customize...’ various functions can be added or
removed from the bar.
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Information Bar: The information bar contains basic information about a selected object. This bar
contains two main areas, the objects tab and the variable tab. The objects tab gives two bits of
information, the coordinates of the pointer in the grid and how many and what type of objects are
selected. This bar is useful when determining what is selected and also if what is selected is the correct
object. The variable tab is a dynamic bar that will change with each tool and part selected. This bar
displays options for various tools when they are selected.

Objects Tab

Objects: 0 ij wi 00000 | 1000000 2 e oo P
|[: 253,36 415) = ae 00000 Wm jlz% !
Variable Tab

Tool Pallet: The bar on the left hand side of Torchmate CAD contains the pull out menus for basic
drawing tools as well as the means to manipulate them. Each tool will be further explained throughout
this manual but essentially any drawing from scratch will start here.

Measure Tools --.__*__E*___ Select Tool

A —1extTools
Zoom Tools =——=q
@-—\\/eld Tools

ShapeTools =4 . \ode EditTool

ScanTools =——>»x

Tool Path Tools i—-(—Flll & Stroke Tool
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Navigation and Selection Methods:

Being able to move around the drawing area and manipulate objects is the key to successful drawing. In
Torchmate CAD there are a few ways to simplify this process so that drawing can be done more
efficiently.

Moving around the work area is done in a few ways. The scroll bars along the bottom and right of the
area can be used to pan the page. Another way is to use click the third mouse button this brings up a pan
hand that allows click and drag movement. On most computer mice the third mouse button will activate
when the scroll wheel is depressed.

L] Torchmate CAD - Lintithed1 €18 (& 3.3
Fis [t Leyout Avarge Machine Transform Image Wew Optors Help

Dbgects 0 see w0m He- aoeo Y 0o dy o O oomm 0

i S vnwm 41 eom 3 oo 3y @ -

RFGED Lo ad | w e AR
3< ¥ D ¥ 3 W » £

R = C W " W W W W ) = 3 W W W W T

Ehcra@op>w

@4] o0
2 5 0 5 P 2 0 52 5 5 P 5 50 0 5 50 0 P 0 S R R S R

| [ELaver )

The pan tool can also be accessed in the ‘Zoom Tools’ menu. Also in the ‘Zoom Tools’ menu are ways to
either zoom in or out. There are short cuts to all of these or they can be accessed from the menu.

aeagides -

Zoom Shortcuts:

Zoom In: F5

Zoom Out: F6

Zoom to selected Object: F7
Zoom to Material: F8

Pan State: 3" Mouse Button
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Selection of objects can be crucial for certain drawing methods in Torchmate CAD. There are multiple
ways to select an object. With pressing the “TAB’ key will select one object, pressing ‘TAB’ repeatedly
will cycle through each object generally in the order they were created. A single object can also be
selected simply by clicking on the edge of the object. To ensure that the object is gets selected the mouse
will change into a crosshair when it is over the edge.

L0 Torchmate CAD - Lintithed .00 L
Fis [t Leyout Avarge Machine Transform Image Wew Optors Help
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Majrim ] [Lverd

Multiple objects can be selected as well, the simplest way to do this is to click and drag with the
‘Selection Tool” around the objects that are to be selected. Multiple objects can also be selected by using
the “Shift’ key. With this method begin by selecting one object then hold down ‘Shift’ on the keyboard;
click on another object both objects will now be selected. This method also works in reverse for
unselecting a single object when multiple objects are selected.

L0 Torchmate CAD - Lintithed .00 e

T Lt Laout Amwge Machine Trrsiom inas Vew Cocons b

see wnmn Hee sooo 3 womn dr 0o e
FCRUTR T | (] .

Otgects ©
|pmatiad e T
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< ¥ D ¥ 3 o » £

= = C W " W W W W ) = 3 W W W W T

L]

ELet a@0E>w

»
Rl oo ¥

PR T oL L ST L BT el el 1 Ll ol |1 Tl el e T T Tl e L P L T T Tl e e e
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When selecting multiple objects it can sometimes become ambiguous as to which ones are selected and
which are not. In Torchmate CAD there is a feature that when enabled highlights each selected object a
certain color. This allows for easy identification of selected objects. To enable this feature go to
‘Options’ =’ Torchmate Setup’ > ’Selection Tool Settings’.

L] Torchmate CAD - Lintitled1 10
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Check the box labeled ‘Highlight selected objects’ the ‘Color picker next to this option adjusts the color.

Selection Settings [‘5—(|

V' Use live cursor K

Cancel

[V Use Filed Region to Select
[ Use default snapping range 4
Shapping range [in pisels) |6 jl

Colar
Picker

Highlight size [in pixels): |2 ﬂ
Speed Scroling

-

" Mo speed scroling
* Permnit speed scroling while moving objects

™ Abways permit speed scroling

Freview Smoothing

v Enable previews

™ On Stopped - Preview only after cursor stops maving
™ Low - Only fast ghost previews

* Medium

" High - Usually ghost previews

(™~ Ghost previews alwaps uzed
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With this feature enabled any selected object will have a colored highlight around it for easy

identification.
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Simple CAD Drawing:

This section describes basic drawing of a simple shape and how to prepare this shape to be cut. Please
refer to later sections of this manual for further explanation on topics discussed.

Creating a Shape:

The Torchmate CAD’s main screen has a tool bar along the left-hand side of the screen and an
information bar along the top. All drawing is done in the main screen defined by the rulers along the
margins. The top bar displays the size of the object, its position and scale. The left-hand tool bar
contains tools used for drawing and manipulating objects.

L] Torchmate CAD - Lintitled1 10
e Edt Layout Araege Machne
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On the left-hand bar the shape tools can be accessed. The ‘Shape Tools’ menu has a few simple shapes to
start most part drawings with (circle, oval, square, polygon, star, arrow and arch).

@ EOCXRD O TR |
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Begin by drawing a simple rectangle; the size is irrelevant as it can be adjusted later. To do this simply
click on the rectangle icon from the ‘Shape Tools’ menu, then click and drag to draw out the rectangle in
the work area.
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To change the rectangle’s size select it by clicking on the edge of the part, then on the top tool bar type in
the ‘X’ and Y’ dimensions that are wanted and press enter.
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Draw a circle using the same method.
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Zoom in on the shape by using the ‘Zoom Tools’ pull out along the left-hand tool bar. Next move the
circle to position it inside of the rectangle.
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Once the circle is positioned in the rectangle select both objects, this can be done a few ways. Using the
‘Selection Tools’ from the left-hand toolbar click and drag a blue box around the two objects this will
select both of them; another way is to go to ‘Edit’ = ‘Select All’.
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With both objects selected go to ‘Arrange’ = ‘Make Path’. This option tells the CAD that all objects
selected are one part, allowing the software to determine if something is a hole or cutout.
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To verify that Torchmate CAD perceives the part as it is intended go to “View’ =’Show Fill’ this option
displays the part as the computer sees it.
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With ‘Show Fill’ on the part will fill in what is perceived as the part. Holes should be empty with the
metal part filled in.
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Once the part is finished it can be resized again if necessary, this resizing will adjust the hole’s size along

with the part’s size.
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If the part is the correct size and ‘Show Fill” appears correct the part is ready to have a tool path created.
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Creating Tool Paths:

To create a tool path go to ‘Machine” = ‘Create Tool Path’ > ‘Male’.
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For this simple part the only changes to be made are under the ‘Lead In/Out’ tab. Create a lead in by
specifying a length and angle. Then press ‘OK’ to create the tool path.
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f+ Line " Online -

Lengh | 01000 m j j
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The screen now has two objects on it, the original part drawing and the tool path.
no longer needed and needs to be removed.
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To eliminate the original drawing go to ‘View’=> ‘Show Tool Paths’ and ensure that it is unchecked.
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The only object visible now is the original object.
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Mod B ayer 1

Select the object and press ‘Delete’ the screen will be blank now. Go back to “View’ = ‘Show Tool
Paths’.
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The only remaining object is the tool path, this part is now ready to export to be cut.
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Exporting Files:

To be able to cut a part it needs to be exported as a ‘DXF’ format. To export go to ‘File’ = ‘Export’.
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Ensure that the ‘Save as type’ is listed as ‘DXF (Polyarc)’. Give the file a name and ensure that the
location of where it is being saved is known. Select ‘Export’ and the file will now be able to be imported

into the driver software to cut.
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Using Guides and Alignment Tools:

Guide Tools:

In Torchmate CAD guides can be used to align objects and nodes. To access the ‘Edit Guides’ menu
have no object selected and right-click on empty space, the menu can also be accessed by going to
‘Options’ select ‘Guides’ and ‘Edit Guides’.
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Guides use the coordinates related with the rulers. To add a line type in the coordinate the line will be at
and select add. Horizontal, vertical, and diagonal lines can be added.
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Once guides are created an object can be ‘snapped’ to the lines.
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To snap an object to the guides move the object over to the guides, when the edge of an object turns
purple the object is aligned to the guide.
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Objects can be snapped to any edge as well as to the center line of the object.
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A diagonal line can be added two different ways, either by specifying a single point to pass through and
an angle or by specifying two points that the line should pass through.
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Any line can be added parallel to an existing line by selecting the ‘Add parallel line at normal offset’
check box. A new box will appear to enter how much of an offset should be used.
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With diagonal lines an object can also be snapped to a corner, it will turn purple similar to an edge or the
center.
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Guide lines work for nodes as well as objects.
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Nodes will snap to the guide lines when they are moved near them, this allows for multiple lines to be
aligned to each other.
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Another way of aligning objects is to go to ‘Options’ select ‘Grid’ and then ‘Snap to grid’ with this
option enabled the object’s edge will attempt to align with the nearest grid line.
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Alignment Tools:

If two objects are created that need to be aligned another method is the alignment tools. Go to ‘Layout’
select ‘Arrange and Distribute’ and then ‘Alignment’ the top tool bar will change to the alignment
options. ‘Alignment’ opens the full options the other choices in the ‘Arrange and Distribute’ are quick
links to the alignment options.
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The alignment reference area specifies what the objects are being aligned to.
Align to Sign Blank — Aligns the selected objects to the materia